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IBM WebSphere® Enterprise Service Bus V6.1 — Lab exercise

WebSphere Enterprise Service Bus lab 1:

Add mediation, mediation flow and message logger
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What this exercise is about

The objective of this lab is to provide you with an initial understanding of how to create a mediation module and
mediation flow in WebSphere Integration Developer V6.1. Then you will run a mediation module with Message
Logger mediation on the WebSphere Enterprise Service Bus V6.1 server. You will also learn how to check

message logger results from an Embedded Derby database using the 'Database Explorer’ from the Data
perspective.

Lab requirements
List of system and software required for the student to complete the lab.

< WebSphere Integration Developer V6.1 with the WebSphere Enterprise Service Bus test server option
installed

What you should be able to do
At the end of this lab you should be able to:

« Import project interchange files into the WebSphere Integration Developer V6.1 development
environment

+ Create and edit mediation modules and mediation flows
e Generate implementation and binding from the development environment
« Navigate the Properties View for mediation information

e Create and learn about a message logger primitive and test by running a JSP on the WebSphere
Enterprise Service Bus V6.1 server

e View message logger results from the derby database using the database explorer
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Introduction

In this lab, you will start by importing a project interchange file that has sample SCA application which will
provide the mediation module you will create a starting point. You will create a brand new mediation module
and learning about what makes the mediation module different from any of the other business integration
modules. You will also create a simple mediation flow with only one type of mediation, message logger
mediation, to start off with. The job of the message logger mediation is to send data, whether the /body,
/context, or /header, to a derby database where you will see what data was sent to the database. The rest of
the mediations are added in Lab-2 of this lab series, and are debugged in Lab-3 to show you how the
mediations work.

The sample application is a stock checking SCA application. The application has a JSP that allows a user to
enter a customer ID which is fed into a call to the portfolio service by way of a stand-alone reference. From
here the portfolio service will first call the customer service to get a customer’s account information like what
stocks they own and how many shares of that stock. Portfolio service will then call the StockQuote service to
see the value of those stocks. Finally, the portfolio service returns a sum to the JSP. Here is a diagram of the
project you are importing in this lab:

Portfolio Manager 1 - Pass in customer ID string, get back a float with total portfolio value

Client JSP 2 - Pass in customer ID string, get back BO with customer info and stock holdings

3 - Pass in stock symbol, get back value of that stock
Enter Customer ID

.
NN NN EEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEs®

(string)
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E Reference I ] CustomerService ; : Export :
: > o—e] :
. Import =0 = StockQuotelnterface .
: . I Dt
- PortfolioManager Module StockQuotelnterface ;

eummE

StockQuoteManager Module
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This original application is great, but the company that is running this application is going to need to distribute
customer data across new multiple “CustomerBackend Modules and easily enhance end-user functionality.

In Lab-1 of this lab series, you will change the application from the above diagram to the one below. You will
add a CustomerRoutingMediation Module between the PortfolioManager service and the
CustomerBackend service to allow you access to message information being passed between them. You will
create a mediation flow called CustomerRoutingFlow that will use a Message Logger mediation to store
message information in a derby database.
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In Lab2, you will add to the Message Logger mediation primitive with a couple others available in
WebSphere Integration Developer V6.1. The main goal for Lab2 is to create another backend,
CustomerServiceExtended, and use mediations to help decide which backend to use. You will first add a
Custom Mediation. The Custom Mediation is a mediation primitive that is used when you want some custom
functionality from mediation. For this custom mediation, it will use a Java snippet that will extract a two digit
prefix from the customer ID and place 2 digit it in the transient context (a business object). Think of transient
context as a scratchpad, a place for information to be stored in a message as it passes through a flow. You
will then add a Database Lookup primitive that uses that two digit prefix from transient context as key to lookup
a backend identifier to place into transient context. The Customer ID prefixes with 11, 22, 33, and 44 will go to
the CustomerService backend. Customer ID prefixes with 55, 66, 77, 88, and 99 will go to a
CustomerServiceExtended backend.

To determine the message routing based on backend identifier, you will add a Message Filter primitive.
The old backend will go directly to the callout for CustomerService and the new backend will go to the XSL
Transformation. The XSL Transformation will transform the CustomerService business object (BO) into the
CustomerServiceExtended business object, and then pass the newly formed message to the callout for
CustomerServiceExtendedPartner instead of the CustomerServicePartner. Notice that this is just the
request. There is also a flow for the response. On the response side, the CustomerServicePartner callout
response will go directly to the CustomerService input response. However, the CustomerServiceExtended
callout response will need to go back through XSL Transformation mediation in order to transform the
response body from the CustomerServiceExtended business object back to the CustomerService business
object. Feeding the CustomerServiceExtended business object to application ends in an error because the
application only knows how to work with the CustomerService business object. This is the reason why you
need an XSL Transformation mediation primitive; to map one business object to another. The diagram will
now look like the one below.
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In Lab-3 of this lab series, you will use the Visual Debugger to step through the application in order to see what
is happening behind the scenes.
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Exercise instructions

Some instructions in this lab are Windows operating system specific. If you plan on running WebSphere
Integration Developer on a Linux operating system you will need to run the appropriate commands and use
appropriate files for Linux. The directory locations are specified in the lab instructions using symbolic
references, as follows:

<WID_HOME> C:\Program Files\IBM\WID61 /opt/IBM/WID61
<ESB_PROFILE_HOME> | <WID_HOME>\pfiesb <WID_HOME>/pflesb

<LAB_FILES> C:\Labfiles61\WESB\Lab1 /tmp/Labfiles61/WESB/Lab1
<WORKSPACE> C:\Labfiles61\WESB\Lab1\workspace | /tmp/Labfiles61/WESB/Lab1/workspace
<SOLUTION> C:\Labfiles61\WESB\Lab1\solution /tmp/Labfiles61/WESB/Lab1l/solution

Windows user note: When directory locations are passed as parameters to a Java" program such as
EJBdeploy or wsadmin, it is necessary to replace the backslashes with forward slashes to follow the Java
convention. For example, C:\LabFiles61\ is replaced by C:/LabFiles61/

<SERVER_NAME> serverl sssr011

<WAS_HOME> C:\Program letc/sscell/AppServer
Files\IBM\WebSphere\AppServer

<HOSTNAME> localhost mvsxxx.rtp.raleigh.ibm.com

<SOAP_PORT> 8880 8880

<TELNET_PORT> N/A 1023

<PROFILE_NAME> AppSrv01 default

<USERID> N/A ssadmin

<PASSWORD> N/A frlday

Instructions for using a remote testing environment, such as z/OS, AlIX or Solaris, can be found at the end of
this document, in the section ‘Task: Adding Remote Server to WebSphere Integration Developer Test
Environment’'.
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Part 1: Prepare environment for lab

In this section of the lab, you will import all the projects inside the WPIv61l _ESB_StartLabl_Pl.zip project

interchange file into your workspace. Remember this is the sample SCA application that you are going to add
ESB specific mediations to.

1. Start WebSphere Integration Developer V6.1 with a workspace location of <WORKSPACE>

+4= Workspace Launcher
Select a workspace

IEM Websphere Integration Developer 6,1 stores ywour projects in a folder called a workspace,
Choose a workspace folder ko use for this session,

Wiarkspace: IC:'l,LaI:uFiIesEul'l,'-.-'-.-'ESB'I,LaI:ul'I,wnrkspan:e j Browse, ., |

[ Use this as the default and do not ask again

| Ik I Zancel |

2. Click the curved arrow at top right to Go to the Business Integration perspective

AT = |
Integration DEVElODE!‘ Goto theBusiness Integration perspective !,f_—lrf__;r

3. Import Project Interchange file, WPIv61_ESB_StartLabl_PI.zip, into the development environment
___a. Right-click inside Business Integration View (top left view in the Business Integration
Perspective) and select Import from the pop-up menu
. — -\"'
. Business Integration |
E#Hed R
Mew L
DpeEn
| e
I Paste
X Delete
Build Path ¥
aireot. |
7 Export. ..
2 | Refresh
Properties
___b. Select Project Interchange from the list. Click Next
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___c. Click the Browse button for “From zip file” and navigate to
<LAB_FILES>/import/WPIv61l_ESB_StartLabl_Pl.zip and hit Open

4= Import Project Interchange Contents
Import Projects —

Import Projects from a zip file. I

= d
Frarm zip file: IC:'l,LaI:uFiIesﬁl'l,WESEi'l,LaI:u1'l,impu:urt'l,'-.-'-.-'F‘Ivﬁ1_ESB_5tartLaI:|1_F'I.zip j Browse, ., |
Project location rook: IC:'l,LaI:uFiIesEu1'|,'-.-'-.-'ESEE'|,LaI:-1'I,W|:-rkspace Browse. .. |

1= CustomerBackend

1= PartfolioLibrary

I=F PortfolioManager

I=F PortfolioManagerClient
=" StockQuoteManager

Deselect all | Select Referenced |

(7) < Back | et = | Eirish I Cancel

___d. Click the Select All button to select all the check boxes for the projects listed.

___e. Click Finish button (projects are imported and auto-build will run).

___f. Verify you have CustomerBackend, PortfolioLibrary, PortfolioManager,
PortfolioManagerClient and StockQuoteManager modules listed in the Business Integration
view.

1= PartfolioManager
E PortfolioManager Client
Ig'“_' StockQuateManager

___g. Verify the ‘WebSphere ESB Server V6.1’ listed in your Servers view

i N ~ P ~
Build Activities | Properties Prnblemsm\ i Lty 18 | =l =0

Server Skatus Skate

T WebsSphere ESB Server ve. i Starked Republish
# webSphere Process Server we.1 = Stopped Fepublish
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Part 2: Create mediation module and mediation flow

In this section of the lab, you will creat a new mediation module and a mediation flow. You can only have one
mediation module for each deployable project. Every mediation module will have a mediation flow inside of it

to connect and control services and mediations.

1. Create a new mediation module.

__a. Right-click in Business Integration view and select New - Mediation Module from the pop-up
menu

" Business Inkegration

7_9 PortfolioManager
::'J PaortfolioManagerClient
:g StockQuoteManager

r H_ﬁ Component Tesk Project
DpEn Gf;} Fram Patkerns

Cik g s
. Copy 1=, Libraty
. Paste & Mediation Module

___b. Inthe ‘New Mediation Module’ panel, enter the parameters listed below:

0 Module Name: CustomerRoutingMediationModule
0 Ensure the target runtime is ‘WebSphere ESB Server V6.1’
0 Select the check box for ‘Create mediation component’

0 Change the name of the module from ‘CustomerRoutingMediationModule’ to
‘CustomerRoutingFlow’
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4= MNew Mediation Module
Mediation module

= |
Create a new mediation module. A mediation module is a project that is used for development, }
wersion management, organizing resources, and deploving o the ESE runtime environmenk,

Module name: |CustumerRDutingMediatiDnMndule -_—
¥ Use defaulk location

Location; | :/Labfilesal AWESE/Labl fworkspaceFinal 3/ CustomerRoutingiediationModule Browse. ., |

Targek runkime: I'-.-'u'el:nSphere ESE Server wh, 1 - j

[|7 Create mediakion u:u:umpu:unent]

Mame: ICustDmerRDutingFIDw -~

Mediation modules can be deploved and run on Web3phere Enterprise Serwvice Bus or WebSphere Process

Server, They conkain Flows, which link together operations for modifying and routing messages between
service consumers and service providers,

(7 < Back:

Einish Cancel

___C. Click Next

___d. Inthe next ‘Select required libraries’ panel, select the check box for ‘PortfolioLibrary’ to add it
as a library project

___e. Click Finish
2. Edit the Assembly Diagram to prepare Mediation Module
___a. Open Assembly Diagram and update Mediation Flow

1) Expand CustomerRoutingMediationModule in the Business Integration view and double
click on Assembly Diagram (_.—ng Assemb

FANREIE) to open it in an Assembly Diagram editor

Elﬂ CustomerRoutingiMediationModule
L Assembly Diagran
. _& Dependencies

2) Notice that a mediation flow is created with the name ‘CustomerRoutingFlow’

D &

Tﬁ_ﬁ CustomerRoutingFlow
o2 .

3) Hover over CustomerRoutingFlow and click the “I” icon ( @ ) that appears to add an
interface

4) Select CustomerService from the list of matching interfaces. Click OK
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Matching interfaces:

f_uskomer Service

@StuckQunteInterFace

___b. Add an Import to CustomerRoutingFlow in Assembly Diagram
1) Drag and drop an import on the right side of CustomerRoutingFlow
a) Click on Import icon from Assembly Diagram tray (= Impart)

b) Click or drag import to the right side of CustomerRoutingFlow

@
[ ] L]

(@) T2, CustomnerRoutingFlav ~ Import1
L] »

2) Change default import name from Importl to CustomerServiceOut

©
L ] L]

] ‘_.'__._' CustarmerRoukingFlow = CuskomerService Ok
H L ] L ]

3) Hover over import or click on import to make the add interface icon appear

Click “I" icon ( @ ) to add an interface
4) Select CustomerService from the list of matching interfaces. Click OK
___ €. Add an Export to CustomerRoutingFlow in Assembly Diagram

1) Drag and drop an Export on the left side of the CustomerRoutingFlow

a) Click on Export icon from Assembly Diagram tray (ﬂ' Export)
b) Click or drag icon to left side of CustomerRoutingFlow

2) Change name from ‘Exportl’ to CustomerServiceln

Y]
[ ] L]
¥ ustamerServiceln (1) [ CustomerRookingFlow (1) | = CustomerServiceOut
[ ]
L] L ]

3) Hover over export or click on Export to make the add interface icon appear

Click “I"icon ( @ ) to add an interface
4) Select CustomerService from the list of matching interfaces. Click OK
___d. Wire components together
1) Your Assembly Diagram should look like the one below
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A =
Ty R

* CLstamerServiceln (1) B4 CustemerRoutingFlow (I) |3 CustomerServicedut

o
LI)
'L

4

2) Click on CustomerServiceln and drag a wire to CustomerRoutingFlow

-
-\

S .
"_JII:J ¥ ustamerServiceln @;J. [, CustomerRoutingFlow I | = CustomerServiceCut

3) Click on CustomerRoutingFlow and drag a wire to CustomerServiceOut

= [ o _
@D % - stomerServiceIn (1) B CustomerRoutingFlow (1) |= CuskomerServiceCuk

i

4) Click OK to any pop-up windows

___e. Generate SCA bindings for Import and Exports.
1) Right-click on CustomerServiceOut and select Generate Binding = SCA Binding
2) Right-click on CustomerServiceln and select Generate Binding - SCA Binding

3) This is what your Assembly Diagram should now look like

=
Vo |

e Al : e
D &2 customer ServiceIn I"“Ié B3, CuskomerRoutingFlow (.1 L =

CuskomerServiceuk

__f. Update binding for CustomerServiceOut
1) Select the Import ‘CustomerServiceOut’ from the Assembly Diagram

2) Open Properties view to Binding tab

.
m\frnhlems SErvErs +* =0

=i Import: Customer5erviceOut [5CA Binding]

Descripkion

Details Module name: |

@‘ Export name: | |

3) Click the Browse button and select CustomerServiceExport from the SCA Export
selection panel
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= SCA Export Selection =]

Choose a SCA export (7 = any character, * = any String):

I*

Matches:

Qualifier:

B CuskomerBackendCustomerServiceExport, expart

(7) | Ok I Cancel

4) Click OK

5) This is how the binding information for the CustomerServiceOut import looks like

Problems | Servers * =0

Description = Import: CustomerServiceOut [SCA Binding]

Details Module name: | CustomerBackend

@‘ Export name: |Custnmer5&rviceExpnrt |

6) Save all work by File = Save All or Crtl + Shift + S

___g- Update import binding ‘CustomerService’ for PortfolioManager module

1) Expand PortfolioManager in the Business Integration view and double click on Assembly
Diagram ('IEJ Assemb

FAMERE to open it in an Assembly Diagram editor

Lﬂ PortFolioLibrary
[=l-5= PortfolioManager
: 'IBI Acsembly Diagram

2) Select the import CustomerService

D

- -
@ & CustomerService

. L]

3) Open Properties View with the CustomerService import highlighted.
Select the Binding tab inside Properties View
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r— i
E Properties &3 Problems | Servers = — O
Diescription & Import: CustomerService (SCA Binding)

Details Module name: | CustomerBackend |

@‘ Export name: |Custnmer5&rviceExpDrt |

4) Click Browse button and select CustomerServiceln (instead of CustomerServiceExport
that the binding is set to)

= SCA Export Selection =]

Choose a 3CA export (7 = any character, * = any String):

I*

Matches;

B CustomerServiceExport

FC1Iskomer ServiceIn

Qualifier

B CustomerRoutingMediationModule ) CustomerServiceIn, expart

7 | QK I Cancel

5) Click OK

| e |
Problems | Servers - 8

Description =1 Import: Customer5ervice [SCA Binding]

Details Module name: | CustomerRoutingMediationtModule

@‘ Export name: |Custumer5&rviceln |

6) Save the Assembly Diagram. File - Save or Ctrl + S

You have now successfully inserted the mediation flow between the PortfolioManager
module and the CustomerBackend module. Redirecting PortfolioManager to
CustomerServiceln allows the message to be operated on by the Mediation Flow and
then passed to the CustomerBackend through the import CustomerServiceOut.
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Part 3: Generate mediation flow implementation and create a mediation

In this section you will generate the implementation for the Mediation Flow. Afterwards, you will create only
one type of mediation; that is, the message logger mediation. It is a simple mediation that sends data (whether
the /body, /context, or /header part of a message) to a derby database. In this section, you will also learn how
to open a derby database and view the data captured by the message logger.

1. Generate implementation for CustomerRoutingFlow

___a. Expand CustomerRoutingMediationModule in the Business Integration view and double click

sembl

on Assembly Diagram ('T'l.;j Sl IR

___b. Right-click on CustomerRoutingFlow in the Assembly Diagram for
CustomerRoutingMediationModule and select Generate Implementation from the pop-up menu.
Select CustomerRoutingMediationModule as the folder from the Generate Implementation

panel
#4= Generate Implementation !EI
Select the Folder where the Mediation Flow implementation will be generated:
[:‘:?:] Ik I Cancel
___c. Click OK.

Note: You can create a mediation flow by right-clicking in the business integration view and select New -
Mediation Flow. However, generating the implementation from the assembly diagram creates a new
Mediation Flow with the name specified in the assembly diagram ‘CustomerRoutingFlow’.

___d. The Mediation Flow Editor will open after generating the mediation CustomerRoutingFlow
implementation.

2. Connect the source operation to target operation in Operation Connections view.
__a. Click on getCustomerInformation section of the CustomerService Interface on the left side of

the Operation Connections view.

(I) CustomerService

ﬁe_ff getCustomerInformation

___b. Drag to the getCustomerinformation section of the CustomerServicePartner on the right side of
the Operation Connections view and unclick. There should be a black line from
CustomerService to CustomerServicePartner
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(I} CustamerService El CustamerServicePartner

%% getCustomerInformation

2 getCustomerInformation -

treate Operation Cu:unneu:tiu:un|

___c. Click on the black line or the getCustomerlinformation section of the CustomerService
Interface (left-hand side)

(I} CustamerService El CustamerServicePartner

2 getCustomerInformation fa B8 getCustomerInfarmation

g

3. Add Message Logger mediation to Mediation Flow diagram

___a. In Mediation Flow View (middle), click to expand ‘Tracing’ from the palette tray on the left side,

# =|
then click to select the ‘Message Logger’ icon (L1/M855388 Loggety 54 finally click to drop it in the
middle of the diagram as shown below:

1 —Palette — - +

e ; b Mediation Flow
[:3 Lt] =] ﬂ[> }'\' =
Input Callaut =] References LI
[~ Favarites ‘ " " P
getCustomerInfor. .. = getCustomerInfor... b CustomerServicePa
T

[~ Transformation

.~ Routing

L~ Tracing -ee—

=
[-7: Message Logoer ape—
D._i Event Emitker

[~ Error Handling

o MEssageloggerl | 53

Input Response

getCustomerInfar, .,

[ Carrelation Ca.. 50 3
<nok specified =

(] Transient Com,., 5 ¥
<nok specified =

[ Shared Context s 3

<nok specified =

_[ r. Request: getCustDmerInFDrmatiDnI =% Response: getCustarmerInformation

4. Wire input and output terminals for the Request

___a. Click on the output terminal "out" of the getCustomerinformation: CustomerService Input node

(on top, left side of mediation flow diagram) and drag to the input terminal of the message

logger

0>

Input =
B

getZustomerInfor. ..
Messageloggerl

___b. Click on the output terminal "out™ of the Message Logger mediation (middle) and drag to the
input terminal of the getCustomerinformation: CustomerServicePartner Callout node (top, right

side)
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o

Callout
IFJ:'J getCustomerInfor., ..
Messageloggerl
5. Wire input and callout terminals for the Response
At the bottom of the Mediation Flow view, there are two tabs. By default you will see the Request
information when enacting the mediation flow view. However, now you need to set up the
Response side of the mediation flow. You can set mediations on both sides of the flow
___a. Select the Response: getCustomerinformation tab
1 — palette — - y "
— ; Mediakion Flow
[ L) @ Pl 2
Callout Response Input Response References w R
.~ Favarites
getCustomerInfar, ., getCustomerInfor, .. b CustomerServicePa
|~ TransForrmation
- [ Carrelation Co,..5 3
|.—= Routing -
|~ Tracing {nut.speclﬁed::::
(= Error Handiing [ Transient Con.., @ 3

<not specified =
[ Shared Context & 3

<not specified =

Exr. Request: getCustomerInformatio

l¢'5J Response: getCustomerInformation

___b. Click on the output terminal ‘out’ of the ‘getCustomerinformation: CustomerServicePartner’
Callout Response node (on the top, left side of mediation flow diagram) and drag to the input
terminal of the ‘getCustomerinformation: CustomerService’ Input Response node

@
Callout Response it El}
nput Response
gekCustamerInfar, .. 5 E

getCustamerInfar, .,

__c¢. Save all with Ctrl + Shift +S or by navigating to File > Save All
6. Investigate Message Logger

___a. Click back on Request tab at bottom of Mediation Flow Editor

[EE,\. Request: getCustDmerInFDrmatiDn" <= Response: getCuskamerInformation

__b. Click on MessagelLoggerl mediation

___¢. Then click on the Properties View (lower right quadrant) while ‘MessagelLoggerl’ is selected

___d. Click on Details tab of Properties view and notice that WebSphere Enterprise Service Bus came

with the data source to derby already set up (jdbc/mediation/messagelLog)
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Build Activities Problems | Servers | Console ¥ =0

7/ Message Logger : MessagelLoggerl

Description
Terminal
[Details Drata source name:* |jl:II:u:,l'mediatil:un,l'messageL-:ug |
Promaoted Properties -
Root; I,l'l:u:u:l*;.f

Transackion made: | Same IEI

___e. The ‘Root’ section sets what level of information you are sent to the database from the message
(body, context, or headers). Leave as /body

___f. Keep the transaction mode at ‘Same’. Notice here you have the option of creating a ‘New’
transaction
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Part 4: Test message logger mediation

In this section, you will run the mediation and use Data view to see what data was populated into the derby

database.

1. Start WebSphere ESB Server and add modules to server

If using a remote testing environment, follow the instructions in ‘Task: Adding remote server to
WebSphere Integration Developer test environment’ at the end of this document.

If using a local testing environment:

_a

b

Open Servers View

Select ‘WebSphere ESB Server V6.1 and click Start button ( o )

p
Build Activities

Properties | Problems m\tunsule #ﬁi ) =L | =, T O

Server

@ ‘WebSphere ESE Server wb. 1 'in Skopped Republish
% WebSphere Process Server w61 (g Stopped Republish

Skatus Skate

__C.

This will take some time. Wait for the server to start

3. Add projects to WebSphere Enterprise Service Bus Server (once the ESB Server is started, not
before).

__a.

In Servers view, right-click on ‘WebSphere ESB Server V6.1' and select ‘Add and Remove
Projects...’

Note: The ESB server you are using is configured with an ESB profile that is part of the installation and not
part of the workspace. Therefore, if you have projects deployed to the server from a different workspace, there

may be some

naming conflicts or other problems. If this occurs, open the Administrative Console and uninstall

the existing projects before adding new projects. That should avoid any potential errors.

b

__C.

_d.

__e.

2008 May, 12

Click Add-All>> button to move all projects to server and click Finish button

Wait for the deployment to finish. While the project is deploying you will see something like the
following in the lower right corner of WebSphere Integration Developer.

Publishing CustomerR...App: (77%) [N

Click the Web browser icon in the WebSphere Integration Developer tools panel to launch a
browser

[ @[ &

Enter http:// <HOSTNAME>:<PORT>/PortfolioManagerClient/index.jsp . Where hostname is the
name of the system where the WebSphere Enterprise Service Bus server is located. Port is the
WC_defaulthost port of the WebSphere Enterprise Service Bus profile.

Ex: http://localhost:9080/PortfolioManagerClient/index.jsp
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Note: You can get the WC_defaulthost port by going to serverindex.xml file in
<WID_HOME>\pflesb\config\cells\esbCell\nodes\esbNode. Where WID_HOME is the location where

WebSphere Integration Developer is installed

Ex: <ESB_PROFILE_HOME>\config\cells\esbCell\nodes\esbNode

___f. Enter 2222222 (2 seven times) in text input box and click Submit to get a response displayed to
the JSP and to the Console View of WebSphere Integration Developer. You should see the
result as "The value is: 28500.0"

Portfolio Application

Enter customer I |

Subrmnit |

The walue 13 285000

__g. Close browser

___h. Stop ‘WebSphere ESB Server V6.1’ by highlighting the WebSphere ESB Server v6.1 in the

Servers View and click Stop button ( &)
(For your information, you cannot view data in a derby database when server is running.)

4. Verify data was sent to database by MessagelLoggerl using the ‘Database Explorer’
___a. Open the ‘Data Perspective’ to view the Database Explorer

___b. From the ‘Window’ menu, select ‘Open Perspective - Other’

Window  Help
et WWindaw . . =
Mew Editor: |

r E‘;‘n‘ Business Integration
Show Wiew ¥ U Profiing and Logging

Dpen Perspective

Cuskomize Perspective, ..

Save Perspective As..,

___C. The '‘Open Perspective’ panel opens
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4= Dpen Perspective

-_Fﬁﬁusiness Integration {default) -
@C'-.-‘S Repository Exploring

B =
fﬁ?Debug

| @ Generic Log Adapter
@

JZEE
;\-‘J'l-..- j

___d. Select ‘Data’ and click OK

___e. The ‘Database Explorer’ shows up at the bottom left corner frame of the WebSphere Integration
Developer canvas

ff !
{19 Database Explarer 52 & = B

=l L Connections
g4 Derby Sample Connection [Derby 10.1]

___f. Select the ‘New Connection’ icon (“+) to launch the ‘New Connection’ wizard. Follow the
inspections below to connect to an existing derby database:

0 Expand ‘Derby’ and the select '10.1’ from the ‘Select a database manager’ list
0 Select ‘Derby Embedded JDBC Driver’ from the ‘JDBC Driver’ list

o Click the Browse button for ‘Database location’, locate and select the appropriate
database under the ‘Connection URL details’ section

Note: Derby databases are located at <ESB_PROFILE_HOME>\databases for an Enterprise Service Bus
profile. By default, the message logger table is created under WPRCSDB database.

o Click the Browse button for ‘Class location’, locate and select the ‘derby.jar’ library
under the ‘Connection URL details’ section

Note: Derby databases libraries are located at <WID_HOME>\runtimes\bi_v61\derby\lib directory.

o0 Enter the ‘User Information’ if necessary

2008 May, 12 IBM WebSphere Enterprise Service Bus 6.1 — Lab exercise Page 21 of 29

WPIv61_ESB_Labl.doc



© Copyright IBM Corporation 2008. All rights reserved

4% New Connection
Connection Parameters
Select the database manager, JDBC driver, and required connection parameters, :‘J;":

~ Connection identification
¥ Use default naming convention

Connection Marme: | WPRRCSDE

Select a database manager: DB driver: Derby Embedded JOBC Driver ;il

- Cloudscape 2 ~Connection URL details
[+- DBz UDE

-- DEZ for i5/05 [Qatal::ase locakion: IC:'I.IEiM'I,'-.-'u'IDE-lﬁ,pf'l,esb'l,datal:uases'l,WF‘RC TI Browse. ..

" EBEbFDr elies ¥ Create the database if required
|- Derbry
folona ™ Uparade the database to the current version

o I eE— JDEC driver class: | org.apache.derbry jdbc EmbeddedOriver
[+ Generic IDEC
- InFarmmice
-- MySal
-- Oracle
-- SQL Server ;I

— User information
User ID: Adminiskrakor

—

[glass location: A1 runtimesthi wa 1 derbyhlibyderbey jar Browse. .. ||

1 | Connection URL: |ju:II:u::derl:u';.:':C:'I,IEGM'I,WIDE1'l,pF'l,esb'l,datal:uases'l,WPRCSDE;

Password: I

Tesk Cu:unneu:tiu:unl ——
(7 < Back Mext > | Einish I Cancel

___g. Click the ‘Test Connection’ button. Ensure the connection is successful

___h. Click Finish

___i. You should see the ‘WPRCSDB’ database listed in the ‘Database Explorer’ as shown below:

(¥4 Database Explorer X Wl =0

R | @ & s Y

- Derby Sample Connection [Derby 10.1]
[+ WPRCSDE [Derby 10.1]  ate———

!

__j. Inthe ‘Database Explorer’, expand WPRCSDB - Schemas - ESBLOG - Tables’ and select
the ‘MSGLOG' table as shown below:
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(¥ Database Explorer X Wl =l

& | D & & T

= [:E',: Connections

-
- Derby Sample Connection [Derby 10.1]
—S» = gy WPRCSDE [Derby 10.1]
= [ WPRCSDE
[:I Buthorization IDs

—— [ Schemas

- EE app
———e -85 EspLOG

E I:I Dependencies
-] Stored Procedures
—3- E|I:| Tahles

- S
#-[_ User-Defined Functions

-

__ k. Now, right click the ‘MSGLOG'’ table and then select ‘Data - Edit’ from the context menu

__|. The ‘MSGLOG' table opens in an editor, where you can view the data populated as shown below:

-

=0

TIMESTAMP[TL... | MESSAGEID[..| MEDIATIONNAM. | MODULENAME [VARCHARY. .

327008 2:11:11 AM EF1365DD-01, Messageloggerl — CustomerRoutingMediation.. ¥
<TIEWN PO

___m. Scroll to the right and click on the table cell below MESSAGE column. This action shows up a
button (I|) to the right of the cell

___n. Click the button to view what the message logger saved from the /body of the message

4= CLOB Cell Editor
CLOB Cell Editor
<vuml version="1.0" encoding="UTF-5"¢ = Impark |
<hody xsiibype="se:get"ustomerInformationRequestMsg"

wrnlns esi="hkkpo v, w3, argf 2001 f¥MLSchema-instance” xmins:se="wsdl. htkp Expart |
wmins:se_1="http:[ParkfalioLibrary /CuskomerService" » —
<se_1igekCustomerInformation =
“rustomerID =222222 2 < fcustomerID =
<se_1:getCustomerInformation =
</body =

™ Set cell value ko null

{ "I_? 1

Cancel |

___ 0. You can either import or export messages in XML format. Depending on your action click ‘Finish’
or ‘Cancel’

5. You are done with this exercise. Go ahead and clean up the workspace (steps below) for future
work
2008 May, 12
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Part 5: Save work and clean up server

Export project as Project Interchange file. Switch to the ‘Business Integration’ perspective (Window - Open
Perspective - Other and then select ‘Business Integration’)

1. In WebSphere Integration Developer, Navigate to File > Export
2.  Select Project Interchange

3. Out of all the projects listed, you only need to add a check next to 6 projects
CustomerBackend
CustomerRoutingMediationModule
PortfolioLibrary
PortfolioManager
PortfolioManagerClient
StockQuoteManager

All other projects are generated upon import of the project interchange
4. Save in C:/LabFiles61/WESB/Lab1/

5.  Name the project interchange WPIv61_ESB_FinishedLabl_Pl.zip
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What you did in this exercise

In this lab, you were provided with an initial understanding of how to create a mediation module and mediation
flow in WebSphere Integration Developer V6.1. You then learned how to run the Message Logger mediation
module on the WebSphere Enterprise Service Bus V6.1 server, and check for results in a derby database.
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Solution instructions
1. Import Solution Project Interchange file

___a. With a blank workspace in WebSphere Integration Developer, Go to File  Import - Project
Interchange

___b. Click on top Browse button and navigate to
<LAB_FILES>/solution/WPIv61 ESB Labl Pl Solution.zip

__C. Select all the 6 project listed
___d. Click Finish button

2. Start with ‘Part 4: Test Message Logger Mediation’
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Task: Adding remote server to WebSphere Integration
Developer test environment

This task describes how to add a remote server to the WebSphere Integration Developer Test environment.
This example uses a z/OS machine.

Create a new remote server.
1. Define a new remote server to WebSphere Integration Developer.
2. Right click on the background of the Servers view to access the pop-up menu.

3. Select New = Server.

Build Activities | Properties | Problems | i Servers 22 £ 0 =0
Server Stakus Skate
Websphere Process Server v6.1 ZE\ Stopped Republish
New P E Server
r 3

4. Inthe New Server dialog, specify the remote server’s host name, <HOSTNAME>.

5. Ensure that the appropriate server type, ‘WebSphere Process v6.1 Server’ or ‘WebSphere ESB
v6.1 Server’, is highlighted in the server type list

@ New Server @
Define a New Server -

Choose the type of server to create

Server's host name: | mvsi.rip.ralesigh.ibm, com| w

Select the server type:

== IBM
WebSphere ESB v6. 1 Server
ﬁ WebSphere Express w5, 1 Server
WebSphere Process vé, 1 Server
|-§__.,5' WebSphere v5 Server Attach
ﬁ WebSphere v5. 1 Server
WebSphere v56.0 Server
WebSphere v&. 1 Server

#-[= Other

View By: | Vendor e

Description: Runs service projects on the WebSphere Process ve. 1 Server.

Server runtime: | \WebSphere Process Server vé, 1 &l Installed Runtimes...

7) Mext = ] [ Finish l [ Cancel
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Click Next

© Copyright IBM Corporation 2008. All rights reserved

On the WebSphere Server Settings page, leave the radio button for SOAP selected, changing the
SOAP connector port to the correct setting (<SOAP_PORT>). If security is on in your server,
check the box for ‘Security is enabled on this server’ and input <USERID> for the user ID and

<PASSWORD> for the password.

€5 New Server

WebSphere Server Settings

Input settings for the new WebSphere server,

Server conneckion bype and admin pork
() RMI {Designed to improve communication with the server)

(%) S0AP (Designed to be mare firevall compatible)

SOAP conneckor port: | 5550

Security is enabled on this server

Current active authentication settings:

User ID: ssadmin
Passward: [TITT
SErver name: sssr1l

Server bype
(2) BASE, Express or unmanaged Metwork Deplovment server

() Metwark Deployment server

Click this button to detect the server bype.

@

I

< Back ” fexk =

J{

Einish Cancel

Click Finish.
The new server should be seen in the Server view.

Euild Ackivities | Properties | Problems | % Servers &4

Server Skatus
WebSphere Process Server w61 ‘i Stopped
wiebSphere Process w61 Server @ mvsxo tp.raleigh.ibm.com £ Stopped

support starting remote servers from the Server View.

| = E
Skate

Republish
Republish

Start the remote server if it is not already started. WebSphere Integration Developer does not

___a. From a command prompt, telnet to the remote system if needed:
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‘telnet <HOSTNAME> <TELNET_PORT>’
userid : <USERID>
password : <PASSWORD>
___b. Navigate to the bin directory for the profile being used:
cd <WAS_HOME>/profiles/<PROFILE_NAME>/bin
___¢. Run the command file to start the server: ./startServer.sh <SERVER_NAME>

__d. Wait for status message indicating server has started:

ADMU32001: Server launched. Waiting for initialization status.

ADMU30001: Server cllsrOl open for e-business; process id is 0000012000000002
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